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ABSTRAK 

 

 Kesehatan adalah salah satu kewajiban yang harus selalu dijaga. Banyak 

orang yang sudah terkena penyakit, akan berobat ke klinik, puskesmas, ataupun 

rumah sakit. Biasanya sebagai penanganan pertama, mereka para pasien akan diberi 

obat untuk meredakan sakitnya. Obat akan membantu pasien dalam proses 

penyembuhan. Pengonsumsian obat juga berpengaruh dalam proses penyembuhan. 

Jika obat tidak dikonsumsi secara teratur, maka akibatnya sakit yang diderita juga 

tidak kunjung sembuh.  

 Berdasarkan permasalahan di atas, penulis membuat alat yang dapat 

memberikan informasi kepada pengguna atau pasien bahwa obat harus segera 

diminum. Alat ini menggunakan ATMega16 sebagai pembaca dari perangkat input 

dan mengontrol perangkat output yang terpasang. Perangkat ini menggunakan Load 

Cell sebagai pengukur dari berat obat yang terdapat dalam wadah yang diletakkan 

di atasnya. Selain itu, alat ini juga mengunakan RTC sebagai pembaca waktu saat 

ini yang akan dibandingkan dengan setpoint yang mengindikasikan kapan obat 

harus diminum. 

  Pada saat RTC menunjukkan angka yang sama dengan nilai pada setpoint 

dan di dalam wadah terdapat obat yang diidentifikasi melalui berat yang terbaca 

oleh Load Cell, maka alarm akan berbunyi dan terus berbunyi sampai berat obat 

berkurang sesuai dengan berat satuan. Pengukuran berat yang dilakukan melalui 

Load Cell akan melalui proses perhitungan ke dalam satuan gram. Selain itu, pada 

alat juga terdapat dua mode yaitu setting mode dan running mode. Setting mode 

digunakan untuk mengatur ketentuan-ketentuan awal sebelum alat berjalan. 

Keyword : ATMega16, Buzzer, Load Cell, Obat, RTC 
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BAB I 

PENDAHULUAN 

 

1.1 Latar Belakang 

Obat adalah suatu bahan atau paduan bahan-bahan yang dimaksudkan untuk 

digunakan dalam menetapkan diagnosis, mencegah, mengurangkan, 

menghilangkan, menyembuhkan penyakit atau gejala penyakit, luka atau kelainan 

fisik dan rohaniah pada manusia atau hewan dan untuk memperelok atau 

memperindah badan atau bagian badan manusia. 

Akan tetapi banyak ditemukan kasus pasien yang tidak kunjung sembuh 

setelah melakukan pengobatan. Salah satu penyebab kegagalan upaya 

penyembuhan adalah kelalaian pada saat mengonsumsi obat yang telah diberikan 

oleh dokter. Kelalaian dalam mengonsumsi obat dapat memberikan dampak buruk 

bagi pasien. Karena kepatuhan pasien dalam mengonsumsi obat sangat 

mempengaruhi kesembuhan penyakit pasien. 

Seorang gadis pernah mendatangi dokter karena keluhan batuknya yang tak 

kunjung sembuh. Awalnya si gadis didiagnosa TB (Tuberculosis), namun karena 

malas minum obat, penyakitnya itu berubah menjadi MDR-TB (Multiple Grug 

Resisten-Tuberculosis). Ia pun harus membayar mahal karena kelalaiannya. MDR-

TB terjadi karena kuman bakteri Mycobacterium Tuberculosa sudah tidak mempan 

lagi dengan obat-obatan TB biasa (Ulfah, 2010). "Biasanya karena 2 bulan minum 

obat TB sudah merasa sembuh, lalu tidak diteruskan. Ketika TB-nya kambuh lagi, 

obatnya sudah tidak mempan, akhirnya jadilah MDR," kata Dr Achmad Hudoyo, 

ketua bidang medis Perhimpunan Pemberantasan TBC Indonesia dalam acara
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 seminar 'The Year of the Lung 2010' di gedung asma RS Persahabatan, Jakarta, 

Kamis (21/1/2010). (Ulfah, 2010) 

Pada saat ini alat pengingat konsumsi obat hanyalah berupa bunyi dari alarm 

yang telah ditentukan dengan waktu konsumsi obat. Jika alat tersebut tidak dibuka 

pada jam konsumsi obat maka alarm akan terus berbunyi sampai alat tersebut telah 

dibuka (Ika, 2016). Alat pengingat konsumsi obat yang beredar dipasaran kurang 

efektif karena tidak bisa mendeteksi apakah jumlah obat tersebut telah berkurang. 

Oleh karena itu pada Tugas Akhir ini akan membahas cara merancang suatu alat 

yang digunakan untuk pengingat konsumsi obat yang telah diberikan oleh dokter 

agar dapat di konsumsi secara teratur menggunakan Load Cell sebagai 

pendeteksinya. 

 

1.2 Rumusan Masalah 

Adapun permasalahan yang akan dihadapi dalam pengerjaan Tugas Akhir ini 

diantaranya adalah: 

1. Bagaimana menggunakan Load Cell sebagai sensor berat untuk pendeteksi obat 

keluar dari kotak obat? 

2. Bagaimana merancang alat yang dapat mengetahui waktu untuk membantu 

pasien dalam mengonsumsi obat secara teratur? 

 

1.3 Tujuan 

Tujuan dari penelitian yang dilakukan adalah sebagai pengingat pasien yang 

sedang atau telah melalui masa pengobatan agar mengkonsumsi obat secara teratur. 
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1.4 Manfaat 

Manfaat dari penelitian yang akan dilakukan adalah sebagai berikut: 

1. Untuk menghindari terlewatnya waktu konsumsi obat. 

2. Konsumen secara teratur mengkonsumsi obatnya sesuai waktu dan banyak obat. 

 

1.5 Batasan Masalah  

Batasan masalah dari penelitian yang akan dilakukan adalah sebagai berikut: 

1. Menggunakan Load Cell 500 gram. 

2. Obat yang diukur mempunyai jenis yang sama. 

3. Dalam satu kali minum obat, obat yang dikonsumsi sebanyak satu butir. 

4. Obat dalam bentuk pil, kapsul, atau tablet. 
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BAB II 

LANDASAN TEORI 

 

2.1 Load Cell 

‘;  

Gambar 2. 1 Load Cell 

 

Load cell adalah sebuah alat uji perangkat listrik yang dapat mengubah suatu 

energi menjadi energi lainnya yang biasa digunakan untuk mengubah suatu gaya 

menjadi sinyal listrik. Perubahan dari satu system ke system lainnya ini tidak 

langsung terjadi dalam dua tahap saja tetapi harus melalui tahap-tahap pengaturan 

mekanikal, kekuatan dan energi dapat merasakan perubahan kondisi dari baik 

menjadi kurang baik. (ino, 2017) 

Pada strain guage (load cell) atau biasa disebut dengan deformasi strain 

gauge. The strain gauge mengukur perubahan yang berpengaruh pada strain 

sebagai sinyal listrik, karena perubahan efektif terjadi pada beban hambatan kawat 

listrik. Sebuah sel/slot beban umumnya terdiri dari empat aspek pengukur regangan 

dalam sistem konfigurasi pada Wheatstone Bridge. Sel/slot beban dari satu strain 
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gauge atau dua pengukur regangan. Output sinyal listrik biasanya disediakan serta 

di urutankan beberapa milivolt dan membutuhkan amplifikasi oleh penguat 

instrumentasi sebelum dapat digunakan. 

Output dari pemantauan perubahan kondisi dapat ditingkatkan untuk 

menghitung gaya yang diterapkan untuk perabaikan dan pemantauan kondisinya. 

Berbagai jenis sel/slot beban yang ada termasuk sel/slot beban hidrolik, 

Strain gage merupakan bagian terpenting dari sebuah load cell, dengan fungsi 

untuk mendeteksi besarnya perubahan dimensi jarak yang disebabkan oleh suatu 

elemen gaya. Strain gages secara umum digunakan dalam pengukuran presisi gaya, 

berat, tekanan, torsi, perpindahan dan kuantitas mekanis lainnya. 

Setelahnya dikonversi menjadi energi tegangan kedalam anggota mekanis. 

Strain gage menghasilkan perubahan pada nilai tahanan yang proporsional dengan 

perubahan jangka panjang atau perubahan melalui lamanya proses. Strain gage 

memiliki dua tipe dasar strain gage yaitu: 

1. Terikat (bonded) 

Bonded strain gage seluruh bagiannya terpasang pada elemen gaya (force 

member) dengan menggunakan semacam bahan perekat. Selagi elemen gaya 

tersebut meregang, strain gage juga dapat memanjang. 

2. Tidak terikat (Unbonded) 

Unbonded strain gage memiliki salah satu sudut akhir yang dipasang pada 

elemen gaya dan sudut akhir satunya lagi dipasang pada pengumpul gaya (force 

collector). Persyaratan ini sering digunakan untuk menguji kelayakan system strain 

gage untuk aplikasi tertentu dimana konstanta kalibrasi strain gage harus stabil, 

artinya tidak berubah terhadap waktu, temperature dan faktor lingkungan lain. 
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Ketelitian pengukuran regangan ± 1μs dan pada daerah regangan ± 10 %, 

ukuran standarisasi strain gage, yaitu panjang 1o dan tebal wo harus kecil. Load 

cell merupakan alat pengujian dan perangkat untuk membantu kinerja dan 

komponen pada sensor load cell (strain gage). 

 

2.2 Mikrokontroler ATMega16 

Mikrokontroler adalah sebuah sistem komputer lengkap dalam satu serpih 

(chip). Mikrokontroler lebih dari sekedar sebuah mikroprosesor karena sudah 

terdapat atau berisikan ROM (Read-Only Memory), RAM (Read-Write Memory), 

beberapa bandar masukan maupun keluaran, dan beberapa peripheral seperti 

pencacah/pewaktu, ADC (Analog to Digital converter), DAC (Digital to Analog 

converter) dan serial komunikasi. (Baskara, 2012) 

Salah satu mikrokontroler yang banyak digunakan saat ini yaitu 

mikrokontroler AVR. AVR adalah mikrokontroler RISC (Reduce Instuction Set 

Compute) 8 bit berdasarkan arsitektur Harvard. Secara umum mikrokontroler AVR 

dapat dapat dikelompokkan menjadi 3 kelompok, yaitu keluarga AT90Sxx, 

ATMega dan ATtiny. Pada dasarnya yang membedakan masing-masing kelas 

adalah memori, peripheral, dan fiturnya. 

Seperti mikroprosesor pada umumnya, secara internal mikrokontroler 

ATMega16 terdiri atas unit-unit fungsionalnya Arithmetic and Logical Unit (ALU), 

himpunan register kerja, register dan dekoder instruksi, dan pewaktu beserta 

komponen kendali lainnya. Berbeda dengan mikroprosesor, mikrokontroler 

menyediakan memori dalam serpih yang sama dengen prosesornya (in chip). 
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2.2.1 Arsitektur ATMega16 

Mikrokontroler ini menggunakan arsitektur Harvard yang memisahkan 

memori program dari memori data, baik bus alamat maupun bus data, sehingga 

pengaksesan program dan data dapat dilakukan secara bersamaan (concurrent). 

Secara garis besar mikrokontroler ATMega16 terdiri dari: 

1. Arsitektur RISC dengan throughput mencapai 16 MIPS pada frekuensi 

16Mhz. 

2. Memiliki kapasitas Flash memori 16Kbyte, EEPROM 512 Byte, dan 

SRAM 1Kbyte. 

3 Saluran I/O 32 buah, yaitu Bandar A, Bandar B, Bandar C, dan Bandar D. 

4 CPU yang terdiri dari 32 buah register. 

5. User interupsi internal dan eksternal. 

6. Bandar antarmuka SPI dan Bandar USART sebagai komunikasi serial. 

7. Fitur Peripheral 

a. Dua buah 8-bit timer/counter dengan prescaler terpisah dan mode 

compare. 

b. Satu buah 16-bit timer/counter dengan  prescaler  terpisah, mode compare, 

dan mode capture. 

c. Real time counter dengan osilator tersendiri. 

d. Empat kanal PWM dan Antarmuka komparator analog. 

e. 8 kanal, 10 bit ADC. 

f. Byte-oriented Two-wire Serial Interface. 

g. Watchdog timer dengan osilator internal. 
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Gambar 2. 2 Blok Diagram ATMega16 

  

2.2.2 Konfigurasi Pena (PIN) ATMega16 

Konfigurasi pena (pin) mikrokontroler Atmega16 dengan kemasan 40- pena 

dapat dilihat pada Gambar 3 Dari gambar tersebut dapat terlihat ATMega16 

memiliki 8 pena untuk masing-masing bandar A (Port A), bandar B (Port B), bandar 

C (Port C), dan bandar D (Port D). 



9 

 

 

 

 

Gambar 2. 3 Pena-pena ATMega16 

 

2.2.3 Deskripsi Mikrokontroler ATMega16 

1. VCC (Power Supply) dan GND (Ground) 

2. Bandar A (PA7..PA0) 

Bandar A berfungsi sebagai input analog pada konverter A/D. Bandar A 

juga sebagai suatu bandar I/O 8-bit dua arah, jika A/D konverter tidak 

digunakan. Pena - pena Bandar dapat menyediakan resistor internal pull-up 

(yang dipilih untuk masing-masing bit). Bandar A output buffer mempunyai 

karakteristik gerakan simetris dengan keduanya sink tinggi dan kemampuan 

sumber. Ketika pena PA0 ke PA7 digunakan sebagai input dan secara eksternal 

ditarik rendah, pena–pena akan memungkinkan arus sumber jika resistor 

internal pull-up diaktifkan. Pena Bandar A adalah tri-stated manakala suatu 
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kondisi reset menjadi aktif, sekalipun waktu habis.  

3. Bandar B (PB7..PB0) 

Bandar B adalah suatu bandar I/O 8-bit dua arah dengan resistor internal 

pull-up (yang dipilih untuk beberapa bit). Bandar B output buffer mempunyai 

karakteristik gerakan simetris dengan keduanya sink tinggi dan kemampuan 

sumber. Sebagai input, pena Bandar B yang secara eksternal ditarik rendah akan 

arus sumber jika resistor pull-up diaktifkan. Pena Bandar B adalah tri-stated 

manakala suatu kondisi reset menjadi aktif, sekalipun waktu habis. 

4. Bandar C (PC7..PC0) 

Bandar C adalah suatu bandar I/O 8-bit dua arah dengan resistor internal 

pull-up (yang dipilih untuk beberapa bit). Bandar C output buffer mempunyai 

karakteristik gerakan simetris dengan keduanya sink tinggi dan kemampuan 

sumber. Sebagai input, pena bandar C yang secara eksternal ditarik rendah akan 

arus sumber jika resistor pull-up diaktifkan. Pena bandar C adalah tri-stated 

manakala suatu kondisi reset menjadi aktif, sekalipun waktu habis. 

5. Bandar D (PD7..PD0 

Bandar D adalah suatu bandar I/O 8-bit dua arah dengan resistor internal 

pull-up (yang dipilih untuk beberapa bit). Bandar D output buffer mempunyai 

karakteristik gerakan simetris dengan keduanya sink tinggi dan kemampuan 

sumber. Sebagai input, pena bandar D yang secara eksternal ditarik rendah akan 

arus sumber jika resistor pull-up diaktifkan. Pena Bandar D adalah tri-stated 

manakala suatu kondisi reset menjadi aktif, sekalipun waktu habis. 

6. RESET (Reset input) 

7. XTAL1 (Input Oscillator) 
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8.  XTAL2 (Output Oscillator) 

9. AVCC adalah pena penyedia tegangan untuk bandar A dan Konverter A/D 

10. AREF adalah pena referensi analog untuk konverter A/D 

 

2.2.4 Peta Memori ATMega16 

1. Memori Program 

Arsitektur ATMega16 mempunyai dua memori utama, yaitu memori data 

dan memori program. Selain itu, ATMega16 memiliki memori EEPROM untuk 

menyimpan data. ATMega16 memiliki 16K byte On-chip In-System 

Reprogrammable Flash Memory untuk menyimpan program. Instruksi 

ATMega16 semuanya memiliki format 16 atau 32 bit, maka memori flash diatur 

dalam 8K x 16 bit. Memori flash dibagi kedalam dua bagian, yaitu bagian 

program boot dan aplikasi seperti terlihat pada Gambar 4 Bootloader adalah 

program kecil yang bekerja pada saat sistem dimulai yang dapat memasukkan 

seluruh program aplikasi ke dalam memori prosesor. 

  

  

Gambar 2. 4 Peta Memori ATMega16 
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2. Memori Data (SRAM) 

Memori data AVR ATMega16 terbagi menjadi 3 bagian, yaitu 32 register 

umum, 64 buah register I/O dan 1 Kbyte SRAM internal. General purpose register 

menempati alamat data terbawah, yaitu $00 sampai $1F. Sedangkan memori I/O 

menempati 64 alamat berikutnya mulai dari $20 hingga $5F. Memori I/O 

merupakan register yang khusus digunakan untuk mengatur fungsi terhadap 

berbagai fitur mikrokontroler seperti kontrol register, timer/counter, fungsi-fungsi 

I/O, dan sebagainya. 1024 alamat berikutnya mulai dari $60 hingga $45F digunakan 

untuk SRAM internal. 

 

3. Memori Data EEPROM 

ATMega16 terdiri dari 512 byte memori data EEPROM 8 bit, data dapat 

ditulis/dibaca dari memori ini, ketika catu daya dimatikan, data terakhir yang ditulis 

Gambar 2. 5 Peta Memori Data ATMega16 
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pada memori EEPROM masih tersimpan pada memori ini, atau dengan kata lain 

memori EEPROM bersifat nonvolatile. Alamat EEPROM mulai dari $000 sampai 

$1FF. 

 

2.2.5 Analog to Digital Converter 

AVR ATMega16 merupakan tipe AVR yang telah dilengkapi dengan 8 saluran 

ADC internal dengan resolusi 10 bit. Dalam mode operasinya, ADC dapat 

dikonfigurasi, baik single ended input maupun differential input. Selain itu, ADC 

ATMega16 memiliki konfigurasi pewaktuan, tegangan referensi, mode operasi, dan 

kemampuan filter derau (noise) yang amat fleksibel sehingga dapat dengan mudah 

disesuaikan dengan kebutuhan dari ADC itu sendiri. ADC pada ATMega16 

memiliki fitur-fitur antara lain: 

1. Resolusi mencapai 10-bit. 

2. Akurasi mencapai ± 2 LSB. 

3. Waktu konversi 13-260µs. 

4. 8 saluran ADC dapat digunakan secara bergantian. 

5. Jangkauan tegangan input ADC bernilai dari 0 hingga VCC. 

6. Disediakan 2,56V tegangan referensi internal ADC. 

7. Mode konversi kontinyu atau mode konversi tunggal. 

8. Interupsi ADC complete. 

9. Sleep Mode Noise canceler. 

Proses inisialisasi ADC meliputi proses penentuan clock, tegangan 

referensi, formal data keluaran, dan modus pembacaan. Register-register yang 

perlu diatur adalah sebagai berikut: 
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1. ADC Control and Status Register A – ADCSR 

Gambar 2. 6 ADC Control and Status Register A –ADCSRA 

 

a. ADEN : 1 = adc enable, 0 = adc disable. 

b. ADCS : 1 = mulai konversi, 0 = konversi belum terjadi. 

c. ADATE : 1 = auto trigger diaktifkan, trigger berasal dari sinyal yang 

dipilih (set pada trigger SFIOR bit ADTS). ADC akan start 

konversi pada edge positif sinyal trigger. 

d. ADIF : diset ke 1, jika konversi ADC selesai dan data register ter-

update. Namun ADC Conversion Complete Interrupt 

dieksekusi jika bit ADIE dan bit-I dalam register SREG diset. 

e. ADIE : diset 1, jika bit-I dalam register SREG di-set. 

f. ADPS[0..2]   : Bit pengatur clock ADC, faktor pembagi 0 … 7 = 2, 4, 8, 

16, 32, 64, 128. 

Tabel 2. 1 Konfigurasi Clock ADC 

ADPS2 ADPS1 ADPS0 Division Factor 

0 0 0 2 

0 0 1 2 

0 1 0 4 

0 1 1 8 

1 0 0 16 

1 0 1 32 

1 1 0 64 

1 1 1 128 

2. ADC Multiplexer-ADMUX 
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Gambar 2. 7 ADC Multiplexer 

a. REFS 0, 1 : Pemilihan tegangan referensi . 

b. ADC 

0 : Vref = Aref. 

1 : vref = AVCC dengan eksternal capasitor pada AREF. 

10 : vref = internal 2.56 volt dengan eksternal kapasitor pada 

AREF.  

c. ADLAR : Untuk setting format data hasil konversi ADC, default = 0. 

3. Special Function IO Register-SFIOR 

SFIOR merupakan register 8 bit pengatur sumber picu konversi ADC, apakah 

dari picu eksternal atau dari picu internal, susunannya seperti yang terlihat pada 

Gambar 2.8 berikut: 

 
Gambar 2. 8 Register SFIOR 

 

ADTS[0...2] : Pemilihan trigger (pengatur picu) untuk konversi ADC, bit-bit 

ini akan berfungsi jika bit ADATE pada register ADCSRA bernilai 1. Konfigurasi 

bit ADTS[0...2]  dapat dilihat pada Tabel 2.2. 

 

Tabel 2. 2 Pemilihan Sumber Picu ADC 

ADTS2 ADTS1 ADTS0 Trigger Source 

0 0 0 Free Running Mode 
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 0 0 1 Analog Comparator 

0 1 0 External Interrupt Request 0 

0 1 1 Timer/Counter0 Compare Match 

1 0 0 Timer/Counter0 Overflow 

1 0 1 Timer/Counter Compare Match B 

1 1 0 Timer/Counter1 Overflow 

1 1 1 Timer/Counter1 Capture Event 

 

2.3 Buzzer 

 

Gambar 2. 9 Buzzer 

 

Buzzer adalah sebuah komponen elektronika yang berfungsi untuk mengubah 

getaran listrik menjadi getaran suara. Pada dasarnya prinsip kerja buzzer hampir 

sama dengan loud speaker, jadi buzzer juga terdiri dari kumparan yang terpasang 

pada diafragma dan kemudian kumparan tersebut dialiri arus sehingga menjadi 

elektromagnet, kumparan tadi akan tertarik ke dalam atau keluar, tergantung dari 

arah arus dan polaritas magnetnya, karena kumparan dipasang pada diafragma 

maka setiap gerakan kumparan akan menggerakkan diafragma secara bolak-balik 

sehingga membuat udara bergetar yang akan menghasilkan suara. Buzzer biasa 

digunakan sebagai indikator bahwa proses telah selesai atau terjadi suatu kesalahan 

pada sebuah alat (alarm). (UNCATEGORIZED, 2007) 
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2.4 Downloader 

Downloader adalah sebuah alat yang digunakan untuk memasukkan program 

ke dalam mikrokontroler, baik itu yang berjenis MCS ataupun AVR semuanya 

butuh downloader, sehingga posisi downloader sangatlah penting untuk dipahami. 

(Fauzi, 2015) 

Downloader bisa juga diartikan sebagai jembatan penghubung antara 

komputer dengan mikrokontroler. Yang mana file.hex yang telah dibuat dari 

compile file.bas dari software BASCOM-AVR dimasukkan ke dalam 

mikrokontroler. Downloader yang umum digunakan untuk memasukkan data dari 

komputer ke mikrokontroler yaitu USB-ASP, namun ada pula yang tidak memakai 

USB-ASP yaitu menggunakan serial paralel port untuk melakukan download 

programnya. Karena USB- ASP menggunakan port USB, maka dapat dilakukan 

pen-download-an dimanapun dan apapun komputernya, namun jika menggunakan 

paralel port hanya terdapat pada PC baik itu Intel maupun AMD, sehingga untuk 

download misal dari laptop sangatlah sulit harus menggunakan konverter usb to 

paralel terlebih dahulu. Berikut ini adalah gambar dari downloader USB-ASP dan 

downloader paralel port. 

 

Gambar 2. 10 Downloader USB-ASP 
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Gambar 2. 11 Downloader Pararel Port 

 

Untuk sistem kerja dari downloader, terutama USB-ASP yaitu dengan cara 

memberikan pin MISO, MOSI, SCK, RESET, dan GROUND pada rangkaian 

downloader, dipasangkan ke mikrokontroler terutama ATMega yaitu pada pin yang 

sama MOSI, MISO,SCK, RESET, GROUND. Sehingga akan nampak seperti bagan 

gambar berikut ini. 

 

Gambar 2. 12 Pemasangan Pin Downloader ke Mikrokontroler 

Keterangan: 

Tabel 2. 3 Keterangan Pemasangan Pin 

Nama Fungsi 

MOSI Jalur data masuk untuk protocol SPI 

MISO Jalur data keluar untuk protocol SPI 

SCK Jalur clock masuk untuk protocol SPI, frekuensi maksimum 20 MHz 

RESET 
Pin untuk melakukan reset secara hardware, active low. Pin diberi 

pulsa berlogika 0 selama minimal 400 ns untuk melakukan reset 
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GND Jalur referensi ground 

 

Untuk pemasangan downloader dengan paralel port sama dengan USB-ASP 

yaitu menggunakan MOSI, MISO, SCK, RESET dan GND, namun berbedanya 

yaitu pada konektornya yang menggunakan DB25, sehingga dari mikrokontroler 

langsung di download ke komputer melalui kabel paralel. Berikut skemanya jika 

menggunakan downloader paralel. 

 

Gambar 2. 13 Skema Downloader Pararel 

 

Untuk skema menggunakan USB-ASP sama seperti menggunakan 

downloader paralel port yang mana menggunakan media kabel sebagai media 

penghubunganya, namun perbedaannya jika pada paralel port menggunakan kabel 

paralel, pada USB-ASP menggunakan kabel USB male to male sehungga tinggal 

colok dari usb komputer ke kepala USB-ASP dan dari USB-ASP dihubungkan ke 

berikut skemanya. 

 
Gambar 2. 14 Skema USB-ASP 

 

2.5 Liquid Cristal Display (LCD) 

Display elektronik adalah salah satu komponen elektronika yang berfungsi 

sebagai tampilan suatu data, baik karakter, huruf ataupun grafik. LCD (Liquid 
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Cristal Display) adalah salah satu jenis display elektronik yang dibuat dengan 

teknologi CMOS logic yang bekerja dengan tidak menghasilkan cahaya tetapi 

memantulkan cahaya yang ada di sekelilingnya terhadap front-lit atau 

mentransmisikan cahaya dari back-lit. LCD (Liquid Cristal Display) berfungsi 

sebagai penampil data baik dalam bentuk karakter, huruf, angka ataupun grafik. 

(UNCATEGORIZED, 2012) 

LCD adalah lapisan dari campuran organik antara lapisan kaca bening dengan 

elektroda transparan indium oksida dalam bentuk tampilan seven-segment dan 

lapisan elektroda pada kaca belakang. Ketika elektroda diaktifkan dengan medan 

listrik (tegangan), molekul organik yang panjang dan silindris menyesuaikan diri 

dengan elektroda dari segmen. Lapisan sandwich memiliki polarizer cahaya 

vertikal depan dan polarizer cahaya horisontal belakang yang diikuti dengan 

lapisan reflektor. Cahaya yang dipantulkan tidak dapat melewati molekul-molekul 

yang telah menyesuaikan diri dan segmen yang diaktifkan terlihat menjadi gelap 

dan membentuk karakter data yang ingin ditampilkan. 

Dalam modul LCD (Liquid Cristal Display) terdapat microcontroller yang 

berfungsi sebagai pengendali tampilan karakter LCD (Liquid Cristal Display). 

Microntroller pada suatu LCD (Liquid Cristal Display) dilengkapi dengan memori 

dan register. Memori yang digunakan microcontroler internal LCD adalah: 

1. DDRAM (Display Data Random Access Memory) merupakan memori tempat 

karakter yang akan ditampilkan berada. 

2. CGRAM (Character Generator Random Access Memory) merupakan memori 

untuk menggambarkan pola sebuah karakter dimana bentuk dari karakter dapat 

diubah-ubah sesuai dengan keinginan. 
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3. CGROM (Character Generator Read Only Memory) merupakan memori untuk 

menggambarkan pola sebuah karakter dimana pola tersebut merupakan 

karakter dasar yang sudah ditentukan secara permanen oleh pabrikan pembuat 

LCD (Liquid Cristal Display) tersebut sehingga pengguna tinggal 

mangambilnya sesuai alamat memorinya dan tidak dapat merubah karakter 

dasar yang ada dalam CGROM. 

Register control yang terdapat dalam suatu LCD diantaranya adalah: 

1. Register perintah yaitu register yang berisi perintah-perintah dari 

mikrokontroler ke panel LCD (Liquid Cristal Display) pada saat proses 

penulisan data atau tempat status dari panel LCD (Liquid Cristal Display) 

dapat dibaca pada saat pembacaan data. 

2. Register data yaitu register untuk menuliskan atau membaca data dari atau ke 

DDRAM. Penulisan data pada register akan menempatkan data tersebut ke 

DDRAM sesuai dengan alamat yang telah diatur sebelumnya. 

Pin, kaki atau jalur input dan kontrol dalam suatu LCD (Liquid Cristal 

Display) diantaranya adalah: 

1. Pin data adalah jalur untuk memberikan data karakter yang ingin ditampilkan 

menggunakan LCD (Liquid Cristal Display) dapat dihubungkan dengan bus 

data dari rangkaian lain seperti mikrokontroler dengan lebar data 8 bit. 

2. Pin RS (Register Select) berfungsi sebagai indikator atau yang menentukan 

jenis data yang masuk, apakah data atau perintah. Logika low menunjukan yang 

masuk adalah perintah, sedangkan logika high menunjukan data. 

3. Pin R/W (Read Write) berfungsi sebagai instruksi pada modul jika low tulis 

data, sedangkan high baca data. 
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4. Pin E (Enable) digunakan untuk memegang data baik masuk atau keluar. 

5. Pin VLCD berfungsi mengatur kecerahan tampilan (kontras) dimana pin ini 

dihubungkan dengan trimpot 5 Kohm, jika tidak digunakan dihubungkan ke, 

sedangkan tegangan catu daya ke LCD sebesar 5 Volt. 

 

Gambar 2. 15 Liquid Cristal Display (LCD) 

2.6 Real Time Clock (RTC) 

RTC (Real time clock) adalah jam elektronik  berupa chip yang dapat 

menghitung waktu (mulai detik hingga tahun) dengan akurat dan menjaga atau 

menyimpan data waktu tersebut secara real time. Karena jam tersebut bekerja real 

time, maka setelah proses hitung waktu dilakukan output datanya langsung 

disimpan atau dikirim ke device  lain melalui sistem antarmuka. (Balea, 2012) 

Chip RTC sering dijumpai pada motherboard PC (biasanya terletak dekat 

chip BIOS). Semua komputer menggunakan RTC karena berfungsi menyimpan 

informasi jam terkini dari komputer yang bersangkutan. RTC dilengkapi dengan 

baterai sebagai pensuplai daya pada chip, sehingga jam akan tetap up-to-date 

walaupun komputer dimatikan. RTC dinilai cukup akurat sebagai pewaktu (timer) 

karena menggunakan osilator kristal. 
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Gambar 2. 16 Real Time Clock (RTC) 

 Salah satu chip RTC yang mudah digunakan adalah DS1307. Pin out seperti 

gambar di bawah: 

 

Gambar 2. 17 Pin Out Chip 

DS1307 memiliki akurasi (kadaluarsa) hingga tahun 2100. Sistem RTC 

DS1307 memerlukan baterai eksternal 3 volt yang terhubung ke pin Vbat dan 

ground. Pin X1 dan X2 dihubungkan dengan kristal osilator 32,768 KHz. 

Sedangkan pin SCL, SDA, dan SQW/OUT dipull-up dengan resistor (nilainya 1k 

s.d 10k) ke VCC. 



24 

 

 

 

2.7 Push Button 

 

 

 

 

 

 

 

 

Push button switch (saklar tombol tekan) adalah perangkat / saklar sederhana 

yang berfungsi untuk menghubungkan atau memutuskan aliran arus listrik dengan 

sistem kerja tekan unlock (tidak mengunci). Sistem kerja unlock disini berarti saklar 

akan bekerja sebagai device penghubung atau pemutus aliran arus listrik saat 

tombol ditekan, dan saat tombol tidak ditekan (dilepas), maka saklar akan kembali 

pada kondisi normal.  

 Sebagai device penghubung atau pemutus, push button switch hanya 

memiliki 2 kondisi, yaitu On dan Off (1 dan 0). Istilah On dan Off ini menjadi sangat 

penting karena semua perangkat listrik yang memerlukan sumber energi listrik pasti 

membutuhkan kondisi On dan Off. 

Karena sistem kerjanya yang unlock dan langsung berhubungan dengan 

operator, push button switch menjadi device paling utama yang biasa digunakan 

untuk memulai dan mengakhiri kerja mesin di industri. Secanggih apapun sebuah 

mesin bisa dipastikan sistem kerjanya tidak terlepas dari keberadaan sebuah saklar 

Gambar 2. 18 Push Button 
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seperti push button switch atau perangkat lain yang sejenis yang bekerja mengatur 

pengkondisian On dan Off. 

 

Gambar 2. 19 Skema Push Button 

 

Berdasarkan fungsi kerjanya yang menghubungkan dan memutuskan, push 

button switch mempunyai 2 tipe kontak yaitu NC (Normally Close) dan NO 

(Normally Open). 

a. NO (Normally Open), merupakan kontak terminal dimana kondisi normalnya 

terbuka (aliran arus listrik tidak mengalir). Dan ketika tombol saklar ditekan, 

kontak yang NO ini akan menjadi menutup (Close) dan mengalirkan atau 

menghubungkan arus listrik. Kontak NO digunakan sebagai penghubung atau 

menyalakan sistem circuit (Push Button ON). 

b. NC (Normally Close), merupakan kontak terminal dimana kondisi normalnya 

tertutup (mengalirkan arus litrik). Dan ketika tombol saklar push button 

ditekan, kontak NC ini akan menjadi membuka (Open), sehingga memutus 

aliran arus listrik. Kontak NC digunakan sebagai pemutus atau mematikan 

sistem circuit (Push Button Off).
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BAB III 

METODE PENELITIAN  

 

 Metode penelitian yang digunakan dalam pengerjaan Tugas Akhir ini 

adalah studi literatur berupa data-data dari masing-masing komponen, perancangan 

perangkat keras dan pembuatan program untuk membuat alat pengingat konsumsi 

obat menggunakan Load Cell. 

 Pada perancangan alat terdapat Load Cell yang digunakan untuk mengukur 

berat obat secara keseluruhan yang terdapat pada wadah yang telah diletakkan di 

atasnya. Alat ini juga menggunakan RTC untuk memasukkan dan mengatur data 

yang berhubungan dengan waktu yang nantinya akan digunakan sebagai setpoint 

waktu meminum obat. Setpoint inilah yang nantinya sebagai acuan dalam 

mengaktifkan alarm. Selain input di atas, terdapat juga push button sebanyak 3 

buah. Push button 1 digunakan sebagai tombol counter untuk menentukan berapa 

kali obat diminum dan juga untuk menentukan banyaknya obat yang ada. Selain itu 

push button 1 juga digunakan untuk memilih Mode yang akan dijalankan. Push 

Button 2 digunakan sebagai tombol OK yang berfungsi untuk menyimpan 

pengaturan RTC mengenai waktu dan juga informasi terkait obat ke EEPROM. 

Push Button 3 digunakan sebagai tombol Back pada saat memilih mode atau pada 

pengaturan yang lain. Perangkat Output yang terdapat dalam alat ini berupa LCD 

dan Buzzer. LCD digunakan untuk menampilkan semua informasi yang terdapat 

pada EEPROM berupa jumlah obat, berat obat, dan waktu saat ini. Buzzer 

digunakan sebagai alarm yang akan berbunyi sesuai dengan setpoint yang diatur. 

Alarm ini akan terus berbunyi hingga obat yang terdapat pada wadah telah  

berkurang
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berkurang sesuai dengan berat satuan obat dan berkurangnya obat akan di ukur oleh 

Load Cell. 

 Sistem ini menggunakan minimum sistem dengan Mikrokontroler 

ATMega16 sebagai unit pengendali. Nilai yang dihasilkan pada Load Cell akan 

digunakan sebagai acuan dalam menentukan berat dari obat. Nilai ini yang akan 

diolah dan di proses oleh ATMega16. Proses selanjutnya adalah membaca berat 

obat apakah berkurang sesuai dengan berat satuan obat yang telah dihitung atau 

tidak pada saat nilai setpoint pada RTC terpenuhi. Jika berat obat masih sama atau 

tidak berkurang, maka ATMega16 akan mengirim sinyal kepada alarm agar terus 

hidup hingga berat obat berkurang. 

 

3.1 Perancangan Sistem  

Secara umum gambar Blok Diagram pada rancangan perangkat keras. 

 

 Gambar 3. 1 Perancangan Perangkat Keras 
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Tiap–tiap bagian dari diagram blok sistem pada gambar 3.1 dapat dijelaskan 

sebagai berikut: 

1.  Input pada Mikrokontroler  

a Load Cell : Untuk mengukur berat obat secara keseluruhan 

yang terdapat dalam wadah. 

b RTC : Untuk membaca waktu saat ini yang digunakan 

sebagai setpoint meminum obat dan juga sebagai 

penghidup alarm. 

C Push Button 1 : Sebagai counter dalam menghitung jumlah obat 

dan sebagai penghitung berapa kali obat diminum. 

Selain itu tombol ini juga digunakan untuk masuk 

ke Mode Setting. Tombol ini berupa tombol sekali 

tekan. 

D Push Button 2 : Sebagai tombol OK untuk menyimpan semua 

pengaturan yang dilakukan pada RTC dan juga 

jumlah obat ke dalam memori EEPROM. 

E Push Button 3 : Sebagai tombol Back atau tombol kembali pada 

saat mengatur mode. 

2. Output pada Mikrokontroler 

A Buzzer : digunakan sebagai alarm yang akan berbunyi saat 

setpoint terpenuhi sebagai penanda bahwa obat 

harus diminum dan akan terus berbunyi jika obat 

belum diambil. 
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B LCD : digunakan untuk menampilkan informasi mengenai 

waktu saat ini, jumlah obat saat ini, dan berat obat 

saat ini. Selain itu, LCD juga digunakan sebagai 

penampil pengaturan pada saat awal alat 

dinyalakan. 

 

3.2 Flowchart Sistem Pengingat Konsumsi Obat 

Untuk dapat menuju pada sistem pengingat konsumsmi obat diperlukan beber 

apa tahapan seperti yang terlihat pada Gambar 3.2: 

 

Gambar 3. 2 Flowchart Sistem Pengingat Konsumsi Obat 
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Proses Flowchart di atas adalah sebagai berikut: 

1. Mulai Program. 

2. Saat alat menyala, RTC dan juga Load Cell akan aktif. Nilai pada RTC akan 

mengikuti waktu pada saat itu sesuai dengan waktu pada Mikrokontroler. Load 

Cell akan langsung membaca nilai yang telah diukur untuk mengindikasikan 

berat obat pada wadah saat itu juga jika di dalam wadah terdapat obat. Kedua 

data nilai tersebut akan langsung disimpan pada memori yang terdapat dalam 

ATMega16 yaitu EEPROM.  

3. Setelah itu, alat akan langsung menjalankan Mode Running sebagai default 

pengaturan saat alat menyala. Untuk masuk ke Mode Setting, pengguna harus 

menekan tombol counter (push button 1) sehingga alat akan langsung 

mengarahkan ke beberapa pengaturan awal pada mode ini. 

4. Jika pengguna masuk pada mode setting, pengguna akan ditanya berapa jumlah 

obat dalam wadah. Untuk menentukan jumlah dapat menggunakan tombol 

counter (push button 1) yang terdapat pada alat. Jumlah obat yang dimasukkan 

maksimal berjumlah 10 buah. Jika lebih dari 10 kali penekanan, counter akan 

kembali ke 1 lagi. 

5. Setelah jumlah obat ditentukan, tekan tombol OK (push button 2) untuk 

menyimpan pengaturan jumlah pada memori. Jika tidak ditekan OK maka 

jumlah obat tidak disimpan dan akan berpengaruh pada perhitungan berat obat 

satuan nantinya. 

6. Tekan tombol Back untuk kembali ke menu sebelumnya untuk pengaturan 

berapa kali obat akan diminum. 
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7. Pengaturan berapa kali obat akan diminum dimasukkan dengan cara yang sama 

dengan menekan tombol counter. Untuk berapa kali obat diminum maksimal 

pengguna memasukkan nilai 3 kali. Jika melebihi 3 kali, counter akan kembali 

ke 1 lagi. 

8. Setelah jumlah obat ditentukan, tekan tombol OK (push button 2) untuk 

menyimpan pengaturan jumlah pada memori. Jika tidak ditekan OK maka 

jumlah obat tidak disimpan dan akan berpengaruh pada perhitungan berat obat 

satuan nantinya. 

9. Mode Setting telah berhasil diatur, maka akan langsung dilanjutkan secara 

otomatis ke mode running. Mode ini melanjutkan apa yang sudah diatur pada 

mode setting. Dalam mode ini tidak terdapat pengaturan apapun. Dalam mode 

ini akan menjalankan apa yang sudah di atur sebelumnya pada RTC maupun 

Load Cell. 

10. Pengecekan RTC apakah sudah sesuai dengan setpoint yang diatur. Jika RTC 

sudah menunjukkan waktu sesuai dengan setpoint, alarm akan berbunyi. 

11. Pengecekan apakah berat obat sudah berkurang sesuai dengan berat satuan obat 

atau belum. Jika berat obat mengalami pengurangan, menandakan bahwa obat 

dalam wadah telah diambil oleh pengguna. Jika terdapat pengurangan berat, 

alarm akan mati. Jika belum, maka alarm akan tetap hidup hingga obat dalam 

wadah diambil. 

12. Pada saat obat diambil, maka jumlah obat akan berkurang 1. Berkurangnya 

jumlah obat dan berkurangnya berat obat satuan akan disimpan pada EEPROM 

sebagai informasi bahwa obat dalam wadah masih dan belum habis. 
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13. Jika jumlah obat dan berat obat dalam wadah sudah mencapai nilai 0, maka 

harus dilakukan pengaturan lagi sehingga harus masuk ke Mode Setting lagi. 

14. Tombol Back digunakan untuk kembali ke pengaturan sebelumnya. 

3.3 Perancangan Perangkat Lunak 

3.3.1 Pembacaan Load Cell 

Load Cell digunakan untuk mengukur berat keseluruhan obat yang terdapat 

dalam wadah. Sensor ini akan mengirim gaya yang akan diterima oleh 

mikrokontroler dalam bentuk tegangan dan akan diubah kedalam satuan massa 

gram melalui proses kalibrasi. Berat yang dihasilkan akan diproses oleh ATMega16 

dan akan ditampilkan setiap saat oleh LCD. Berat obat yang terukur oleh Load Cell 

adalah berat secara keseluruhan obat, sehingga mikrokontroler akan menentukan 

berat satuan obat terlebih dahulu. Berat satuan ini akan disimpan dalam variable 

lain dalam EEPROM. Selanjutnya perubahan berat atau pengurangan berat total 

dengan berat satuan obat akan diproses oleh mikrokontroler untuk menentukan 

apakah perangkat output berupa Buzzer akan menyala atau tidak. Adapun program 

pembacaan Load Cell menggunakan IDE Arduino adalah sebagai berikut: 

#include <HX711.h> 

HX711 Cell(6,7); 

unsigned long Nilai; 

float Gram,Value; 

void Codes_Celll(){ 

  Nilai = Cell.read(); 

  Nilai = (Nilai/10000);  

  Gram  = ((Rumus1*Nilai)-Rumus2); 

  if(Nilai < 360){Gram = 0;} 

} 
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Pada contoh program di atas, pembacaan nilai Load Cell menggunakan 

Cell.read(), dengan menyertakan library dari Load Cell yaitu #include 

<HX711.h>. Selanjutnya adalah proses untuk mengubah nilai dari Load Cell 

menjadi satuan gram. Sehingga akan lebih mudah dalam membaca berat obat jika 

dibaca dalam gram bukan lagi gaya yang dihasilkan oleh Load Cell. 

 

3.3.2 Pembacaan RTC 

RTC merupakan perangkat yang dapat membaca informasi waktu pada saat 

ini berupa jam, menit, dan detik. Penggunaan RTC pada alat digunakan untuk 

perbandingan dengan setpoint untuk menentukan waktu minum obat berapa kali 

sehari sesuai dengan ketentuan dan juga pengaturan yang telah dilakukan 

sebelumnya. RTC akan memberikan informasi jam, menit, detik pada saat ini. 

Waktu ini akan dibandingkan dengan setpoint yang telah ditetapkan. Jika informasi 

pada RTC sama dengan nilai setpoint, akan menghidupkan aktuator berupa buzzer 

sebagai alarm untuk meminum obat. Berikut adalah program untuk membaca nilai 

RTC: 

#include <DS3231.h> 

RTClib RTC; 

int Jam,Menit,Detik;  

void Codes_Waktu(){ 

  DateTime now = RTC.now();             

  Detik        = now.second();           

  Menit        = now.minute();           

  Jam          = now.hour()  ; 

} 
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Pada contoh program di atas, pembacaan RTC menggunakan RTC.now(), dengan 

menyertakan library dari RTC yaitu #include <DS3231.h>. Selanjutnya 

adalah proses untuk mengambil nilai detik pada RTC menggunakan 

now.second(). Untuk mengambil nilai menit menggunakan now.minute(). 

Dan untuk mengambil nilai jam menggunakan now.hour(). Nilai-nilai tersebut 

akan disimpan ke dalam variabel lain agar mudah di akses maupun disimpan pada 

memori.  

 

3.3.3 Pembacaan EEPROM 

EEPROM digunakan untuk menyimpan segala informasi berkaitan dengan 

RTC dan Load Cell. Dalam kata lain EEPROM akan menyimpan waktu saat ini, 

jumlah obat, dan juga berat obat. EEPROM juga akan diakses oleh mikrokontroler 

untuk menentukan apakah data yang ada pada EEPROM sesuai dengan setpoint 

yang telah diatur. Pembacaan EEPROM dapat dilakukan dengan program di bawah: 

#include <EEPROM.h> 

int EpromHari,EpromHari_1; 

int EpromObat,EpromObat_1; 

float Gram,Value; 

int Jumlah_Hari=1,Jumlah_Obat=1; 

EEPROM.write(0,Jumlah_Hari); 

EEPROM.write(1,Jumlah_Obat); 

EpromHari = EEPROM.read(0); 

EpromObat = EEPROM.read(1); 

EpromObat_1 = Gram / Value; 

EEPROM.write(1,EpromObat_1); 
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Program untuk menulis atau memasukkan sebuah nilai ke dalam EEPROM dapat 

menggunakan EEPROM.write(0,Jumlah_Hari). 0 berarti EEPROM bit ke-

0 yang digunakan sebagai penyimpanan data jumlah hari. Dan untuk membaca data 

pada EEPROM dapat menggunakan program EEPROM.read(0), yang artinya 

mikrokontroler akan membaca nilai EEPROM pada bit ke-0. 

 

3.3.4 Pengaturan nilai Setpoint 

Setpoint disini digunakan untuk menentukan kapan pengguna harus 

meminum obat yang terdapat dalam wadah. Nilai setpoint hanya diperuntukkan 

untuk jumlah obat sebanyak 1 buah. Sehingga hanya akan ada aturan 3x1, 2x1, dan 

1x1. 3x1 artinya obat yang diminum sebanyak 1 buah dan diminum sebanyak 3 kali 

dalam sehari. 2x1 artinya obat yang diminum sebanyak 1 buah dan diminum 

sebanyak 2 kali dalam sehari. Dan 1x1 artinya obat yang diminum sebanyak 1 buah 

dan diminum sehari sekali saja. Dalam sehari waktu yang tersedia adalah 24 jam, 

sehingga jika kita akan menggunakan aturan 3x1, maka 24 jam dibagi dengan 3 kali 

sehingga didapatkan 8 jam sekali untuk meminum obat. Jika 2x1, maka obat harus 

diminum setiap 12 jam sekali. Dan jika 1x1, maka obat harus diminum pada jam 

yang sama setiap harinya. Berikut adalah aturan waktu yang akan digunakan 

sebagai setpoint dalam meminum obat: 

a. Aturan 3x1 : 06:00 

14:00 

22:00 

 

b. Aturan 2x1 : 06:00 

18:00 

 

c. Aturan 1x1 : 06:00 
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3.4 Perancangan Mekanik 

3.4.1 Desain Mekanik  

 

Keterangan pada Gambar 3.3: 

1. A : LCD 

2. B : Push Button 

3. C : Mikrokontroler ATMega16 

4. D : RTC 

5. E : Load Cell 

6. F :  Wadah atau Kotak Obat 

7. G : Buzzer 

 

  

 

Gambar 3. 3 Perancangan Desain Mekanik 
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3.4.2 Hasil Mekanik Keseluruhan Alat 

 

 

 

      Gambar 3. 5 Mekanik Alat Tampak Depan 

 

 

Gambar 3. 4 Mekanik Alat Tampak Atas 
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3.5 Perancangan Perangkat Keras 

Perancangan perangkat keras pada alat ini akan mengatur tentang rangkaian 

elektronika dari tiap komponen input maupun output yang terhubung. Tujuan dari 

perancangan ini adalah agar komponen yang terhubung dapat digunakan 

sebagaimana mestinya sesuai dengan tegangan yang diperlukan. 

 

3.5.1 Perancangan Rangkaian Load Cell   

Perangkat ini merupakan bagian masukan dari ATMega16 yang digunakan 

sebagai pengukur berat dari obat yang terdapat dalam wadah. Pada Load Cell 

terdapat empat kabel yang akan terhubung dengan Mikrokontroler. Masing-masing 

kabel pada Load Cell tidak langsung dihubungkan dengan mikrokontroler, akan 

tetapi dihubungkan terlebih dahulu dengan Modul HX711 yang berfungsi untuk 

mengolah pembacaan nilai pada Load Cell menjadi tegangan yang akan masuk ke 

dalam mikrokontroler sebagai tegangan input. Berikut adalah rancangan elektonika 

dari Load Cell dan Modul HX711: 

 
Gambar 3. 6 Wiring Load Cell dan Modul HX711 
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1.5.2 Perancangan Rangkaian RTC 

RTC digunakan untuk membaca waktu pada saat ini. Jika pada perancangan 

elektonika RTC terdapat kesalahan kabel, maka RTC tidak dapat membaca waktu. 

Hal ini berpengaruh pada waktu konsumsi obat yang tidak tepat pula. Nilai yang 

ditunjukkan pada RTC akan dibandingkan dengan setpoint yang dari awal sudah 

diatur. Nilai RTC sama dengan nilai setpoint maka aktuator berupa buzzer akan 

menyala. Nilai RTC juga akan ditampilkan melalui LCD yang sudah terpasang. 

Berikut rangkaian elektronika untuk RTC: 

 

 

 

1.5.3 Perancangan Rangkaian LCD 

Dengan adanya LCD, segala informasi yang tersimpan dalam memori 

ATMega16 dapat ditampilkan. Informasi terkait waktu saat ini, jumlah obat, berat 

obat juga akan ditampilkan untuk informasi umum bagi pengguna. LCD juga akan 

membantu pengguna dalam pengaturan mode setting yang akan dilakukan nantinya. 

Berikut rancangan elektronika LCD dengan ATMega16: 

Gambar 3. 7 Rangkaian Elektronika RTC 
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1.5.4 Perancangan Rangkaian Push Button 

Perancangan rangkaian tombol masukan dimaksudkan agar nantinya tombol 

dapat berfungsi dengan baik atau tidak. Dalam penggunaan perangkat input dikenal 

istilah pull up yang bertujuan untuk mendefinisikan termasuk active high atau 

active low. Pada alat menggunakan pull up sehingga saat ditekan akan 

menghasilkan sinyal high. Dalam penggunaan pull up dapat melalui dua cara yaitu 

menambah resistor pada rangkaian atau menggunakan pull up pada program. Pada 

perancangan alat ini, penulis menggunakan pull up pada program sehingga tidak 

memerlukan resistor tambahan pada rangkaian. Berikut adalah rangkaian 

elekronika push button tanpa pull up rangkaian: 

 

Gambar 3. 8 Rangkaian Elektronika LCD 
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Gambar 3. 9 Rangkaian Elektronika Push Button 

 

1.5.5 Perancangan Rangkaian Buzzer 

Buzzer akan digununakan sebagai alarm tanda bahwa obat harus diminum. 

Jika obat belum diminum, maka tidak ada pengurangan berat sehingga alarm akan 

tetap menyala. Nyala dari buzzer tergantung pada berat obat dalam wadah. Berikut 

adalah rangakaian elektronika dari Buzzer: 

 

Gambar 3. 10 Rangkaian Elektronika Buzzer 
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1.5.6 Rangkaian Elektronika Keseluruhan Alat  

Berdasarkan rangkaian masing-masing komponen, dapat dibuat rangkaian 

untuk keseluruhan alat mulai dari perangkat input, mikrokontroler ATMega16, dan 

juga perangkat output yang telah terhubung satu sama lain sesuai dengan 

pengalamatan PIN I/O pada ATMega16. Berikut adalah keseluruhan rangkaian alat 

yang telah dibuat: 

 

Gambar 3. 11 Rangkaian Elektronika Keseluruhan Alat 

 

Dari rangkaian di atas, berikut adalah tabel alamat PIN ATMega16 yang digunakan 

sebagai perangkat input maupun perangkat output: 

Tabel 3. 1 Pengalamatan I/O 

No. Perangkat Input/Output Source PIN ATMega16 

1. Push Button 1  

 

 

Input 

 

 

 

 

Ground 

PB0 

2. Push Button 2 PB1 

3. Push Button 3 PB2 

4. 

Load Cell 

Red 

HX711  

E+ GND GND 

Black E- VCC VCC 

White A+ SCK PB7 

Green A- DT PB6 
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No. Perangkat Input/Output Source PIN ATMega16 

5. 

RTC 

SCL 

 

 

Input - 

 

PC0 

SDA PC1 

VCC VCC 

GND GND 

6. 

LCD 

VSS 

Output 

Potensio 
GND 

VDD 

VEE 

- 

RS PA0 

RW GND 

E PA1 

D4 PA4 

D5 PA5 

D6 PA6 

D7 PA7 

7. Buzzer Ground PD0 

 

 

1.6 Pengujian Perangkat  

Pengujian ini bertujuan untuk pengecekan keadaan perangkat apakah 

berfungsi sebagai mana mestinya sehingga dalam pengambilan data serta 

pengaturan perangkat keluaran dapat dilakukan dengan baik. 

 

1.6.2 Pengujian Minimum Sistem ATMega16 

Dalam pengujian ini akan dilakukan dengan memberikan program sederhana 

ke dalam mikrokontroler ATMega16 menggunakan software IDE Arduino. Tujuan 

dari pengujian ini adalah untuk mengetahui apakah mikrokontroler ATMega16 

dapat digunakan dan berjalan dengan baik saat menjalankan program. Apabila 

mikrokontroler tidak dapat menerima program yang dikirimkan, maka 

mikrokontroler mengalami kesalahan. Selain itu jika mikrokontroler menjalankan 

program yang tidak sesuai berarti menandakan bahwa mikrokontroler tidak dapat 

digunakan sebagaimana mestinya. 
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1.6.3 Pengujian Load Cell 

Pengujian ini bertujuan untuk pengambilan data dan hasil pembacaan nilai 

gaya mekanik yang dihasilkan oleh Load Cell. Hasil ini yang nantinya akan 

dikirimkan ke ATMega16 menjadi inputan. Nilai  yang dibaca oleh mikrokontroler 

selanjutnya akan dikonversi kedalam satuan gram agar pembacaan oleh pengguna 

dapat lebih mudah. Nilai gram inilah yang akan ditampilkan pada LCD dan juga 

sebagai informasi dari berat dan juga jumlah obat yang tersisa.  

 

1.6.4 Pengujian RTC 

Pengujian ini bertujuan untuk mengambil data waktu yang terdapat pada 

mikrokontroler sesuai dengan waktu sebenarnya. Data yang diambil berupa jam, 

menit, detik. Data waktu ini akan ditampilkan pada LCD sebagai informasi 

pengguna jika waktu telah menujukkan pukul sekian. Data ini juga yang akan 

dibandingkan dengan nilai setpoint waktu yang dari awal sudah ditetapkan untuk 

menghidupkan actuator berupa buzzer. Jika pembacaan RTC tidak berjalan baik, 

maka akan berpengaruh pada konsumsi obat yang seharusnya, dan akan berakibat 

tidak baik pada pengguna sehingga pembacaan RTC harus benar-benar sesuai 

dengan sebenarnya. 
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BAB IV 

HASIL DAN PEMBAHASAN 

 

 Hasil dan Pembahasan yang dilakukan penulis merupakan pengujian dan 

pengamatan yang dilakukan terhadap perangkat keras dan perangkat lunak dari 

sistem secara keseluruhan yang telah selesai dibuat untuk mengetahui komponen-

komponen dan program yang digunakan dalam sistem ini apakah berjalan dengan 

baik sesuai yang diharapkan.  

 

4.1 Hasil Pengujian Minimum Sistem ATMega16 

Pengujian pada ATMega16 merupakan pengujian yang dilakukan pertama 

kali karena perangkat ini adalah perangkat utama yang digunakan untuk membaca 

perangkat input dan mengontrol perangkat output. Pengujian ini dilakukan dengan 

memasukkan program yang sebelumnya telah dibuat menggunakan aplikasi IDE 

Arduino. Adapun alat yang digunakan dalam melakukan pengujian ini adalah 

sebagai berikut: 

1. ATMega16 beserta alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 

Tahapan yang dilakukan dalam pengujian perangkat sebagai berikut: 

1. Menyiapkan alat yang sudah terdapat ATMega16. 

2. Menghubungkan Alat dengan Komputer menggunakan kabel USB 

Downloader.
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3. Membuka aplikasi IDE Arduino. 

4. Membuka program yang sebelumnya sudah dibuat. Memilih menu File -> 

Open      -> cari lokasi penyimpanan program -> Klik Open. 

 

Gambar 4. 1 Membuka Program Melalui Menu File 

 

 

Gambar 4. 2 Pencarian Lokasi Penyimpanan Program 
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5. Memastikan program yang ditulis tidak terdapat error dengan melakukan 

verify terlebih dahulu. Memilih menu Sketch -> Verify/Compile. 

 

Gambar 4. 3 Proses Verify Program 

Jika tidak terdapat kesalahan dalam program, maka pada error message tidak 

akan menampilkan pesan error.  
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Gambar 4. 4 Error Message "Done Compiling" 

       

Gambar 4. 5 Error Message 
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6. Jika program sudah benar, mengatur Port yang sesuai dengan port komputer 

yang digunakan. Penyesuaian port dapat dilihat melalui device manager pada 

komputer. Untuk mengatur port dapat memilih menu Tools -> Programmer -

> Pilih USBasp.  

 

Gambar 4. 6 Pengaturan Port USB 

 

7. Pengaturan Board yang sesuai dengan mikrokontroler yang digunakan. 

memilih menu Tools -> Board -> memilih mikrokontroler. 
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Gambar 4. 7 Pengaturan Board 

 Pada pengaturan Board di atas, tidak ditemukan ATMega sebagai 

mikrokontroler yang sesuai. Hal ini dikarenakan IDE Arduino diperuntukkan untuk 

mikrokontroler Arduino bukan ATMega, sehingga diperlukan penginstalan untuk 

ATMega agar dapat dibaca oleh IDE Arduino. Berikut cara untuk menginstal Board 

tambahan: 

a. Membuka menu File -> Preference 

 

Gambar 4. 8 Tampilan Menu File 
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Gambar 4. 9 Tampilan Menu Preference 

b. Mengisi “Additional Boards Manager URLs:” dengan alamat URL untuk 

memasukkan ATMega, lalu OK. 

 

Gambar 4. 10 Pengisian Alamat URL untuk ATMega16 
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c. Membuka menu Tools -> Board -> Board Manager. 

 

Gambar 4. 11 Tampilan Board Manager 

d. Mencari “Gelatino” pada Board Manager -> Install. Gelatino merupakan 

tambahan board untuk AVR 8-bit selain Arduino yang tidak terdapat pada 

Arduino IDE. Gelatino dapat digunakan untuk ATMega128, ATMega16, 

ATMega32, ATMega1284, dan ATMega162. 

 

Gambar 4. 12 Install Board Gelatino 
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Gambar 4. 13 Proses Install Gelatino 

Setelah proses install selesai, tutup Board Manager. Lihat pada Board, Board akan 

menampilkan ATMega yang telah diinstall. 

 

Gambar 4. 14 Hasil Board Setelah di Install 
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e. Memilih Board Gelatino-16 w/ATmega16. 

8. Setelah semua pengaturan sesuai, selanjutnya mengirim program ke 

mikrokontroler. Memilih menu Sketch -> Upload. Jika proses upload 

berhasil, maka tidak akan ada pesan kesalahan pada error message, itu berarti 

menandakan bahwa mikrokontroler ATMega16 dapat digunakan sesuai 

fungsi dan program yang dijalankan. 

 

4.2 Hasil Pengujian Tombol Counter 

Pengujian Tombol Pintu ini dilakukan untuk menguji apakah tombol dapat 

berjalan sebagaimana mestinya. Pengujian ini dilakukan untuk tombol Counter 

(Push Button 1). Kegunaan tombol ini digunakan untuk menambah jumlah obat dari 

satu hingga sepuluh dan setelah sepuluh akan kembali lagi ke satu. Hal ini 

dikarenakan sudah ditetapkan terlebih dahulu batas maksimal dalam jumlah obat 

adalah sepuluh obat. Hal tersebut juga berlaku untuk menetapkan berapa kali obat 

diminum dalam sehari. Berbeda dengan jumlah obat, berapa kali minum obat 

ditentukan dengan maksimal tiga kali sehari bukan sepuluh, sehingga pada saat 

counter aktif akan menambah nilai dari satu hingga tiga dan akan kembali ke satu 

lagi setelah lebih dari tiga. Adapun alat yang digunakan dalam pengujian ini antara 

lain: 

1. Rangkaian Alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 
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Tahapan yang dilakukan dalam pengujian perangkat adalah sebagai berikut: 

1. Menghubungkan Alat dengan Komputer menggunakan Kabel USB 

Downloader. 

2. Membuat program menggunakan aplikasi IDE Arduino dengan memberikan 

pengalamatan untuk perangkat input sesuai dengan kegunaan dan kebutuhan 

dari perangkat (Tabel 3.1).  

Program yang dibuat untuk melakukan pengujian tombol counter seperti berikut: 

while(digitalRead(2) != LOW){ 

lcd.setCursor(0,0);lcd.print("Masukan Berapa Kali"); 

lcd.setCursor(0,1);lcd.print(" Sehari Obat Harus ");                  

lcd.setCursor(0,2);lcd.print("     Diminum       ");                  

lcd.setCursor(9,3);lcd.print(Jumlah_Hari);                  

if(digitalRead(0) == LOW){  

Jumlah_Hari++; 

   if(Jumlah_Hari >= 4){Jumlah_Hari = 1;} 

delay(250); 

} 

 

Program di atas adalah program untuk counter berapa kali meminum obat, sehingga 

pada cek kondisi jika jumlah hari atau banyak minum obat dalam sehari melebihi 

tiga kali akan kembali ke satu lagi. Untuk jumlah obat juga dilakukan dengan 

program yang sama akan tetapi kondisinya berubah menjadi: 

if(Jumlah_Obat >= 11){Jumlah_Obat = 1;lcd.clear();} 

3. Memasukkan program ke dalam ATMega dengan perintah Upload. 

4. Menekan tombol pada alat yang telah dibuat. 

5. Melihat perubahan nilai yang dihasilkan tombol counter pada LCD yang telah 

terpasang di alat. 
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Berikut adalah hasil dari pengujian dari tombol counter baik untuk jumlah obat 

maupun jumlah konsumsi obat dalam sehari. 

Tabel 4. 1 Pengujian Tombol Counter untuk Jumlah Obat 

Penekanan Tombol ke- Tampilan di LCD 

1 1 

2 2 

3 3 

4 4 

5 5 

6 6 

7 7 

8 8 

9 9 

10 10 

11 1 

12 2 

13 3 

14 4 

15 5 

16 6 

17 7 

18 8 

19 9 

20 10 

21 1 

 

Tabel 4. 2 Pengujian Tombol Counter untuk Banyak Konsumsi Obat dalam Sehari 

Penekanan Tombol ke- Tampilan di LCD 

1 1 

2 2 

3 3 

4 1 

5 2 

6 3 

7 1 

8 2 

9 3 

10 1 
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Dari hasil pengujian di atas, dapat dilihat bahwa tombol counter berfungsi 

dengan baik sesuai dengan program yang dibuat dan juga merepresentasikan 

maksud yang ingin dicapai oleh penulis yaitu akan kembali ke satu jika telah 

melebihi batas maksimal dari tiap-tiap pengaturan. Sehingga dapat disimpulkan 

bahwa pengujian tombol counter tidak terdapat kesalahan dan selalu berhasil. 

 

Gambar 4. 15 Counter Berapa Kali Obat Diminum 

 

 

Gambar 4. 16 Counter Berapa Kali Obat Diminum 
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4.3 Hasil Pengujian Pengambilan Data RTC 

Pengujian ini dilakukan untuk mengetahui waktu yang telah dibaca RTC. 

Waktu ini nantinya yang akan dibandingkan dengan setpoint yang sejak awal telah 

ditetapkan. Jika waktu yang dica RTC sesuai, maka ATMega akan menghidupkan 

alarm sebagai hasil dari perbandingan waktu tersebut. Adapun alat yang digunakan 

dalam pengujian ini: 

1. Rangkaian Alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 

Tahapan yang dilakukan dalam pengujian perangkat adalah sebagai berikut: 

1. Menghubungkan Alat dengan Komputer menggunakan Kabel USB 

Downloader. 

2. Membuat program menggunakan aplikasi IDE Arduino dengan memberikan 

pengalamatan untuk perangkat input sesuai dengan kegunaan dan kebutuhan 

dari perangkat (Tabel 3.1).  Program untuk membaca RTC dapat dilihat pada 

subbab 3.3.2 Pembacaan RTC. 

3. Memasukkan program ke dalam ATMega dengan perintah Upload. 

4. Melihat dan mencatat setiap perubahan waktu yang dapat dilihat pada LCD 

yang terpasang. Bandingkan waktu yang dibaca oleh RTC dengan jam atau 

pembaca waktu yang ada, pada kali ini penulis menggunakan jam digital yang 

terdapat pada handphone. 
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Tabel 4. 3 Data Pembacaan RTC 

No RTC (jam:menit) Handphone (jam:menit) 

1 07:02 07:02 

2 07:03 07:03 

3 07:04 07:04 

4 07:05 07:05 

5 07:06 07:06 

6 07:07 07:07 

7 07:08 07:08 

8 15:07 15:07 

9 15:08 15:08 

10 15:09 15:09 

11 15:10 15:10 

12 15:11 15:11 

13 15:12 15:12 

14 15:13 15:13 

15 20:37 20:37 

16 20:38 20:38 

17 20:39 20:39 

18 20:40 20:40 

19 20:41 20:41 

20 20:42 20:42 

 

 

Gambar 4. 17 Hasil Pengujian RTC terhadap Waktu Sesungguhnya 
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Gambar 4. 18 Hasil Pengujian RTC terhadap Waktu Sesungguhnya 

 

Berdasarkan hasil pengujian yang ditunjukkan di atas, dapat disimpulkan 

bahwa RTC dapat membaca waktu sesuai dengan waktu saat ini. Dengan 

kesesuaian waktu yang ditunjukkan RTC maupun pada handphone dapat 

disimpulkan bahwa RTC berjalan sesuai fungsinya dengan baik sehingga dapat 

digunakan pada alat maupun program yang dibuat. 

 

4.4 Hasil Pengujian Load Cell 

Pengujian ini dilakukan untuk mengetahui nilai yang dibaca oleh Load Cell. 

Nilai yang didapat akan di olah oleh ATMega ke dalam satuan gram agar pengguna 

dapat lebih  mudah mengetahui berat dari obat dalam wadah. Untuk mengubah nilai 

Load Cell ke dalam gram dapat menggunakan rumus: 

Nilai = (Nilai/10000) 

  Gram  = (0.7241*Nilai)-260.68) 

Nilai pada rumus adalah  nilai yang dihasilkan oleh Load Cell, lalu di bagi 

10000 agar nilai tersebut menjadi lebih kecil dan lebih mudah dalam perhitungan. 
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Untuk mendapatkan rumus kalibrasi tersebut didapat dengan membandingkan nilai 

pada saat wadah tidak berisi obat apapun dengan nilai pada saat wadah terdapat 

obat. Nilai Load Cell dan juga berat asli obat yang akan digunakan sebagai acuan. 

Tabel 4. 4 Perbandingan Berat Obat Pada Load Cell 

Nilai Load Cell (/10000) Berat Obat (gr) 

360 0 

377 12,31 

 

Setelah mengetahui nilai dari Load Cell maupun berat asli, maka dibuatlah grafik 

sehingga dapat menampilkan rumus kalibrasi yang digunakan untuk mengubah 

nilai Load Cell ke dalam bentuk gram. 

 

Gambar 4. 19 Grafik Hasil Perbandingan Berat Obat 

  

Adapun alat yang digunakan dalam pengujian rangkaian ini: 

1. Rangkaian Alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 



62 

 

 

 

Tahapan yang dilakukan dalam pengujian perangkat adalah sebagai berikut: 

1. Menghubungkan Alat dengan Komputer menggunakan Kabel USB 

Downloader. 

2. Membuat program menggunakan aplikasi IDE Arduino dengan memberikan 

pengalamatan untuk perangkat input sesuai dengan kegunaan dan kebutuhan 

dari perangkat (Tabel 3.1).  Program untuk membaca Load Cell  dapat dilihat 

pada subbab 3.3.1 Pembacaan Load Cell. 

3. Memasukkan program ke dalam ATMega dengan perintah Upload. 

4. Mengamati nilai yang telah diubah kedalam satuan gram. Mencatat hasil dan 

membandingkan lagi dengan berat yang dihasilkan oleh timbangan. 

Tabel 4. 5 Hasil Pengukuran Berat Obat dengan Load Cell 

No 
Jumlah 

Obat 

Berat Load Cell 

(gr) 

Berat Timbangan 

(gr) 
Selisih 

1 1 0,72 0,73 0,01 

2 2 1,44 1,46 0,02 

3 3 2,17 2,19 0,02 

4 4 2,89 2,9 0,01 

5 5 3,62 3,64 0,02 

6 6 4,34 4,37 0,03 

7 7 5,06 5,09 0,03 

8 8 5,79 5,85 0,06 

9 9 6,51 6,56 0,05 

10 10 7,24 7,31 0,07 

11 10 7,24 7,31 0,07 

12 9 6,51 6,6 0,09 

13 8 5,79 5,83 0,04 

14 7 5,06 5,12 0,06 

15 6 4,34 4,37 0,03 

16 5 3,62 3,63 0,01 

17 4 2,89 2,92 0,03 

18 3 2,17 2,19 0,02 

19 2 1,44 1,46 0,02 

20 1 0,72 0,75 0,03 

Rata-rata  0,036 
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Dapat dilihat berdasarkan hasil di atas, selisih berat obat yang terdapat pada 

Load Cell maupun timbangan tidak memiliki selisih atau perbedaan yang 

signifikan. Selisih dari masing-masing berat obat paling besar hanya mencapai nilai 

0.09 gram, merupakan angka yang kecil untuk perbedaan dari tiap pembacaan berat 

obat. Sehingga masih memungkinkan untuk menyatakan bahwa nilai tersebut masih 

setara. Dapat dilihat pula rata-rata selisih berat obat hanya berkisar pada angka 

0.036, angka ini lebih kecil dari perbedaan pada saat jumlah obat sembilan. Angka 

yang sangat kecil untuk menunjukkan error berat obat. Hal ini menandakan bahwa 

proses kalibrasi atau proses mengubah nilai Load Cell ke dalam gram dapat 

diterima dengan baik untuk proses pada alat. 

 

 

4.5 Hasil Pengujian Buzzer 

Buzzer merupakan perangkat yang digunakan sebagai alarm dalam alat ini. 

Fungsinya sebagai penanda bahwa obat harus segera diminum. Jika obat tidak 

segera diminum pada saat setpoint terpenuhi , maka buzzer selaku alarm akan terus 

berbunyi sampai obat diminum. Buzzer sendiri adalah perangkat yang akan menyala 

jika mendapat beda tegangan. Dalam rangkaian salah satu kaki buzzer akan 

terhubung dengan ground dan kaki satunya akan terhubung dengan PIN ATMega16 

yang akan memberikan beda tegangan. Sehingga jika PIN tersebut aktif, maka 

buzzer akan menyala. Untuk menyalakan PIN tersebut dapat menggunakan 

program seperti: 

digitalWrite(8,HIGH); 
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Program di atas adalah program untuk mengaktifkan PIN 8 pada ATMega16 yang 

terhubung dengan buzzer. Sehingga pada saat PIN tersebut diaktifkan, maka buzzer 

juga akan menyala. Adapun alat yang digunakan dalam pengujian buzzer: 

1. Rangkaian Alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 

Tahapan yang dilakukan dalam pengujian perangkat adalah sebagai berikut: 

1. Menghubungkan Alat dengan Komputer menggunakan Kabel USB 

Downloader. 

2. Membuat program menggunakan aplikasi IDE Arduino dengan memberikan 

pengalamatan untuk perangkat input sesuai dengan kegunaan dan kebutuhan 

dari perangkat (Tabel 3.1).   

3. Memasukkan program ke dalam ATMega dengan perintah Upload. 

4. Mengamati perubahan yang terjadi pada buzzer. 

Tabel 4. 6 Hasil Pengujian PIN ATMega16 terhadap Buzzer 

No Kondisi PIN ATMega16 Buzzer 

1 0 Mati 

2 1 Menyala 

3 0 Mati 

4 1 Menyala 

5 0 Mati 

6 1 Menyala 

7 0 Mati 

8 1 Menyala 

9 0 Mati 

10 1 Menyala 

11 0 Mati 

12 1 Menyala 

13 1 Menyala 

14 0 Mati 

15 1 Menyala 
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No Kondisi PIN ATMega16 Buzzer 

16 0 Mati 

17 0 Mati 

18 1 Menyala 

19 0 Mati 

20 1 Menyala 
 

Setelah pengujian buzzer tersebut, selanjutnya pengujian buzzer terhadap setpoint. 

Pada saat setpoint terpenuhi, maka buzzer akan menyala. Berikut adalah hasil dari 

pengujian buzzer terhadap setpoint (3.3.4 Pengaturan Nilai Setpoint).. 

Tabel 4. 7 Hasil Pengujian Buzzer terhadap Setpoint 3x1 

No Setpoint (waktu) Buzzer 

1 05:59 Mati 

2 06:00 Menyala 

3 06:01 Mati 

4 13:59 Mati 

5 14:00 Menyala 

6 14:01 Mati 

7 21:59 Mati 

8 22:00 Menyala 

9 22:01 Mati 

10 05:59 Mati 

11 06:00 Menyala 

12 06:01 Mati 

13 13:59 Mati 

14 14:00 Menyala 

15 14:01 Mati 

16 21:59 Mati 

17 22:00 Menyala 

18 22:01 Mati 

  

4.6 Hasil Pengujian LCD  

Pengujian LCD ini dilakukan untuk menampilkan data dari pembacaan Load 

Cell serta RTC. Pengujian ini dilakukan bertujuan untruk mengetahui apakah LCD 

sudah bekerja  serta dapat membaca data yang dikirimkan oleh mikrokontroler pada 

saat alat berjalan. Adapun alat yang digunakan dalam pengujian ini: 
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1. Rangkaian Alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 

Tahapan yang dilakukan dalam pengujian perangkat adalah sebagai berikut: 

1. Menghubungkan Alat dengan Komputer menggunakan Kabel USB 

Downloader. 

2. Membuat program menggunakan aplikasi IDE Arduino dengan memberikan 

pengalamatan untuk perangkat input sesuai dengan kegunaan dan kebutuhan 

dari perangkat (Tabel 3.1).   

3. Memasukkan program ke dalam ATMega dengan perintah Upload. 

4. Mengamati LCD apakah menampilkan apa yang ditulis pada program. 

 

Gambar 4. 20 Tampilan Pada LCD 

Dari hasil pengujian pada gamabar 4.17  menunjukkan bahwa data yang 

dikirim dari mikrokontroler ATMega16 dapat diterima dengan baik dan benar oleh 

LCD. 
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4.7 Hasil Pengujian Alat Keseluruhan 

Pada pengujian akhir ini adalah tahap pengujian pada kesuluruhan sistem. 

dengan keseluruhan program yang sudah di uji pada Mikrokontroler ATmega16 

sebagai pusat kendali, untuk mengatur input atau output pada sistem. Pengujian ini 

bertujuan untuk mengetahui seluruh komponen bisa bekerja dengan baik. Pengujian 

sistem secara keseluruhan ini adalah dapat mengetahui berat dan juga jumlah obat 

dalam wadah dan juga memberitahukan kepada pengguna untuk meminum obat 

dalam ewadah melalui buzzer yang terpasang. Berikut adalah alat yang digunakan 

dalam pengujian ini: 

1. Rangkaian Alat 

2. Komputer 

3. Aplikasi IDE Arduino 

4. USB Downloader 

Tahapan yang dilakukan dalam pengujian perangkat adalah sebagai berikut: 

1. Menghubungkan Alat dengan Komputer menggunakan Kabel USB 

Downloader. 

2. Membuat program menggunakan aplikasi IDE Arduino dengan memberikan 

pengalamatan untuk perangkat input sesuai dengan kegunaan dan kebutuhan 

dari perangkat (Tabel 3.1).   

3. Memasukkan program ke dalam ATMega dengan perintah Upload. 

4. Mengamati perubahan yang terjadi pada alat. 

Tabel 4. 8 Hasil Pengujian Aturan 3x1 

No 
Waktu 

(jam:menit:detik) 

Berat 

(gr) 

Jumlah 

(buah) 
Alarm Keterangan 

1 05:58:00 7.24 10 Mati Berhasil 

2 05:59:00 7.24 10 Mati Berhasil 
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No 
Waktu 

(jam:menit:detik) 

Berat 

(gr) 

Jumlah 

(buah) 
Alarm Keterangan 

3 06:00:00 7.24 10 Menyala Berhasil 

4 06:00:21 6.51 9 Mati Berhasil 

5 06:01:00 6.51 9 Mati Berhasil 

6 13:58:00 6.51 9 Mati Berhasil 

7 13:59:00 6.51 9 Mati Berhasil 

8 14:00:00 6.51 9 Menyala Berhasil 

9 14:01:03 6.51 9 Menyala Berhasil 

10 14:01:18 5.79 8 Mati Berhasil 

11 21:59:00 5.79 8 Mati Berhasil 

12 22:00:00 5.79 8 Menyala Berhasil 

13 22:01:00 5.79 8 Menyala Berhasil 

14 22:02:15 5.79 8 Menyala Berhasil 

15 22:02:47 5.06 7 Mati Berhasil 

16 05:59:00 5.06 7 Mati Berhasil 

17 06:00:00 5.06 7 Menyala Berhasil 

18 06:00:45 4.34 6 Mati Berhasil 

19 13:59:00 4.34 6 Mati Berhasil 

20 14:00:00 4.34 6 Menyala Berhasil 

22 14:00:31 3.62 5 Mati Berhasil 

23 21:59:00 3.62 5 Mati Berhasil 

24 22:00:00 3.62 5 Menyala Berhasil 

25 22:00:22 2.89 4 Mati Berhasil 

26 05:59:00 2.89 4 Mati Berhasil 

27 06:00:00 2.89 4 Menyala Berhasil 

28 06:00:17 2.17 3 Mati Berhasil 

29 13:59:00 2.17 3 Mati Berhasil 

30 14:00:00 2.17 3 Menyala Berhasil 

31 14:00:30 1.44 2 Mati Berhasil 

32 21:59:00 1.44 2 Mati Berhasil 

33 22:00:00 1.44 2 Menyala Berhasil 

34 22:00:20 0.72 1 Mati Berhasil 

35 05:59:00 0.72 1 Mati Berhasil 

36 06:00:00 0.72 1 Menyala Berhasil 

37 06:00:37 0.00 0 Mati Berhasil 

 

Di atas adalah hasil pengujian saat pengaturan yang dilakukan pada setting 

mode menggunakan banyak obat sejumlah 10 buah dan diminum 3 kali dalam 

sehari. Dari hasil tersebut dapat dilihat bahwa alarm akan menyala pada saat waktu 

setpoint tercapai. Dan akan berhenti berbunyi pada saat adanya pengurangan jumlah 

obat atau berat obat dalam wadah. Jika tidak ada obat yang berkurang, maka alarm 
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akan terus berbunyi.  Untuk cara kerja serta hidup matinya alarm pada aturan 2x1 

dan 1x1 sama dengan cara kerja aturan 3x1, yang membedakan hanya waktu yang 

menjadi setpoint saja. Berikut adalah hasil untuk pengujian aturan 2x1. 

Tabel 4. 9 Hasil Pengujian Aturan 2x1 

No 
Waktu 

(jam:menit:detik) 

Berat 

(gr) 

Jumlah 

(buah) 
Alarm Keterangan 

1 05:59:00 7.24 10 Mati Berhasil 

2 06:00:00 7.24 10 Menyala Berhasil 

3 06:00:20 6.51 9 Mati Berhasil 

4 17:59:00 6.51 9 Mati Berhasil 

5 18:00:00 6.51 9 Menyala Berhasil 

6 18:00:29 5.79 8 Mati Berhasil 

7 05:59:00 5.79 8 Mati Berhasil 

8 06:00:00 5.79 8 Menyala Berhasil 

9 06:00:50 5.06 7 Mati Berhasil 

10 17:59:00 5.06 7 Mati Berhasil 

11 18:00:00 5.06 7 Menyala Berhasil 

12 18:00:32 4.34 6 Mati Berhasil 

13 05:59:00 4.34 6 Mati Berhasil 

14 06:00:00 4.34 6 Menyala Berhasil 

15 06:00:30 3.62 5 Mati Berhasil 

16 17:59:00 3.62 5 Mati Berhasil 

17 18:00:00 3.62 5 Menyala Berhasil 

18 18:00:30 2.89 4 Mati Berhasil 

19 05:59:00 2.89 4 Mati Berhasil 

20 06:00:00 2.89 4 Menyala Berhasil 

22 06:00:19 2.17 3 Mati Berhasil 

23 17:59:00 2.17 3 Mati Berhasil 

24 18:00:00 2.17 3 Menyala Berhasil 

25 18:00:41 1.44 2 Mati Berhasil 

26 05:59:00 1.44 2 Mati Berhasil 

27 06:00:00 1.44 2 Menyala Berhasil 

28 06:00:49 0.72 1 Mati Berhasil 

29 17:59:00 0.72 1 Mati Berhasil 

30 18:00:00 0.72 1 Menyala Berhasil 

31 18:00:35 0.00 0 Mati Berhasil 
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Untuk pengujian aturan 1x1 dapat dilihat pada hasil di bawah ini: 

Tabel 4. 10 Hasil Pengujian Aturan 1x1 

No 
Waktu 

(jam:menit) 

Berat 

(gr) 

Jumlah 

(buah) 
Alarm Keterangan 

1 05:59:00 7.24 10 Mati Berhasil 

2 06:00:00 7.24 10 Menyala Berhasil 

3 06:00:30 6.51 9 Mati Berhasil 

4 05:59:00 6.51 9 Mati Berhasil 

5 06:00:00 6.51 9 Menyala Berhasil 

6 06:00:53 5.79 8 Mati Berhasil 

7 05:59:00 5.79 8 Mati Berhasil 

8 06:00:00 5.79 8 Menyala Berhasil 

9 06:00:30 5.06 7 Mati Berhasil 

10 05:59:00 5.06 7 Mati Berhasil 

11 06:00:00 5.06 7 Menyala Berhasil 

12 06:00:32 4.34 6 Mati Berhasil 

13 05:59:00 4.34 6 Mati Berhasil 

14 06:00:00 4.34 6 Menyala Berhasil 

15 06:00:27 3.62 5 Mati Berhasil 

16 05:59:00 3.62 5 Mati Berhasil 

17 06:00:00 3.62 5 Menyala Berhasil 

18 06:00:43 2.89 4 Mati Berhasil 

19 05:59:00 2.89 4 Mati Berhasil 

20 06:00:00 2.89 4 Menyala Berhasil 

22 06:00:36 2.17 3 Mati Berhasil 

23 05:59:00 2.17 3 Mati Berhasil 

24 06:00:00 2.17 3 Menyala Berhasil 

25 06:00:20 1.44 2 Mati Berhasil 

26 05:59:00 1.44 2 Mati Berhasil 

27 06:00:00 1.44 2 Menyala Berhasil 

28 06:00:36 0.72 1 Mati Berhasil 

29 05:59:00 0.72 1 Mati Berhasil 

30 06:00:00 0.72 1 Menyala Berhasil 

31 06:00:50 0.00 0 Mati Berhasil 

 

Dari ketiga hasil tersebut, pengujian yang dilakukan tidak mengalami 

kesalahan pada saat waktu setpoint terpenuhi. Pada saat setpoint terpenuhi, alarm 

akan menyala dan akan mati pada saat obat berkurang, sesuai dengan aturan yang 

telah dibuat. Dan pengujian ini sesuai dengan pengaturan yang dilakukan juga pada 

setting mode sebelumnya.  
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BAB V 

PENUTUP 

 

5.1 Kesimpulan 

Adapun kesimpulan yang didapat berdasarkan hasil pengujian yang 

dilakukan adalah sebagai berikut: 

1. Nilai yang dibaca oleh Load Cell akan diolah oleh mikrokontroler ATMega16.  

Nilai ini akan di bagi dengan 10000 agar nilai tersebut lebih mudah diolah. 

Selanjutnya nilai tersebut akan diubah ke dalam satuan gram. Nilai Load Cell 

terkecil adalah 360 untuk merepresentasikan berat 0 gram. Dalam menentukan 

gram dapat menggunakan persamaan linier yang didapatkan dari hasil 

perbandingan antara nilai yang dibaca Load Cell yang sudah dibagi dengan berat 

obat sesungguhnya yang ditimbang dengan timbangan digital. 

2. Untuk mengetahui bahwa obat sudah diminum atau belum adalah dengan 

melihat apakah berat Load Cell mengalami penurunan dengan berat satuan obat.  

3.  Dalam pengaturan alat ini terdapat dua mode yang digunakan yaitu setting mode 

dan running mode. Setting mode digunakan untuk mengatur jumlah obat yang 

terdapat dalam wadah dan juga pengaturan berapa kali obat diminum dalam 

sehari. Pengaturan jumlah obat terdapat jumlah maksimal yaitu sepuluh. Jika 

nilai jumlah pada saat ditambah sudah melebihi sepuluh, maka nilai tersebut 

akan kembali lagi ke 1. Begitu juga pengaturan berapa kali obat diminum dalam 

sehari, maksimal ada tiga kali sehingga jika sudah melebihi tiga akan kembali 

ke 1 lagi. Dalam kasus ini, obat yang diminum sejumlah 1 obat dalam sekali 

minum. Pengaturan berapa kali obat diminum ada tiga yaitu 3x1, 2x1,1x1.
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4. Pengujian nilai setpoint yang di atur adalah dengan membandingkannya dengan 

nilai yang dibaca oleh RTC yang dipasang pada alat. RTC ini akan memberikan 

informasi terkait waktu saat ini. Informasi ini akan ditampilkan oleh LCD.  

 

5.2 Saran 

Saran dalam pegembangan maupun perbaikan mengenai Tugas Akhir ini 

adalah Alat dapat diintegrasikan dengan perangkat Android sehingga dalam 

memunculkan pesan yang mengharuskan pengguna meminum obat tidak melalui 

buzzer, tetapi pesan lewat sms pada perangkat android. 
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